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  CARStat Overview 1  

What is CARStat?
Statistical methods for detection monitoring have been well 
studied in recent years (see Gibbons, 1994a, 1996; Davis and 
McNichols, 1994; USEPA 1992; and ASTM Standard D6312-
98, formerly PS64-96). Although equally important, statistical 
methods for assessment sampling, ongoing monitoring and 
corrective action sampling and monitoring have received less 
attention.
The CARStat computer program provides the first completely 
integrated statistical analysis system that can be used to evaluate 
data collected as part of assessment monitoring and corrective 
action programs for environmental sampling of soil, 
groundwater, air, surface water, and waste streams. CARStat 
uses a common database and a similar user interface to the 
DUMPStat program (Gibbons, 1994b), which provides 
automated solutions for groundwater detection monitoring.

One may ask why statistical analysis is necessary in assessment 
and corrective action monitoring. Why not simply compare each 
measurement to the corresponding criterion? There are several 
reasons why statistical methods are essential in assessment and 
corrective action sampling programs. First, a single 
measurement indicates very little about the true concentration in 
the sampling location of interest, and with only one sample there 
is no way of knowing if the measured concentration is a typical 
or an extreme value. The objective is to compare the true 
concentration (or some interval that contains it) to the relevant 
criterion or standard. Second, in many cases the constituents of 

CARStat can share database 
and facility information with 
DUMPStat for a truly 
comprehensive, integrated 
solution.
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What is CARStat?
interest are naturally occurring (e.g., metals) and the naturally 
existing concentrations may exceed the relevant criteria. In this 
case, the relevant comparison is to background (e.g., off-site soil 
or upgradient groundwater) and not to a fixed criterion. As such, 
background data must be statistically characterized to obtain a 
statistical estimate of an upper bound for the naturally occurring 
concentrations so that it can be confidently determined if on-site 
concentrations are above background levels. Third, there is 
often a need to compare numerous potential constituents of 
concern to criteria or background, at numerous sampling 
locations. By chance alone there will be exceedances as the 
number of comparisons becomes large. The statistical approach 
to this problem can ensure that false positive results are 
minimized.
CARStat is an easy-to-learn system for performing state-of-the-
art environmental statistical monitoring analyses. Its 
methodology is based on the research and work of Dr. Robert 
Gibbons. Its statistical procedures balance both false positive 
and false negative rates for the entire facility and offer complete 
consistency with USEPA Subtitle C and D regulations, and all 
USEPA guidance, and ASTM D6312-98.

CARStat can merge in data sets of any size, and it maintains the 
information in a site-specific database. When subsequent 
monitoring events occur, the data are simply appended to the 
database and analyses can be performed at a click of your mouse.

Why use CARStat?
◗ Users need not understand the complexities of environ-

mental statistics in order to produce statistically rigorous 
analyses.

◗ Both site-wide false positive (indicating contamination 
where there is none) and false negative (missing contamina-
tion when it is present) rates are optimally balanced at min-
imal levels, computed via Monte Carlo simulation and 
displayed.

All statistical modules were 
written by Dr. Robert Gibbons.
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Types of Analyses
◗ Costly corrective action can be avoided through the use of 
better statistical screening in assessment and compliance 
monitoring.

CARStat allows you to group your sampling locations into 
potential areas of concern (PAOCs) and run Comparison to 
Background, Comparison to Standard and Natural Attenuation 
analyses. Results can be shown over time or by sampling 
location. You set the confidence levels you want and the type of 
distribution to fit the data to—or let the program automatically 
fit the data to the most appropriate distribution. 
In addition to the statistical modules, CARStat also includes time 
series graphs, analytical data summary tables and electronic data 
exporting functionality to help you review and characterize your 
data.

Types of Analyses

Comparison to Background
If you select the Comparison to Background button, CARStat 
compares onsite/downgradient data to background 
concentration distributions obtained from offsite/upgradient 
locations using the current database. The analysis determines:
◗ Normal, lognormal, and nonparametric prediction limits 

computed from the offsite/upgradient data for individual 
onsite/downgradient measurements. OR

◗ The mean of a series of measurements collected from a sin-
gle location. OR

◗ The mean of a series of onsite/downgradient locations for 
a specified time interval.

All computations are automatically conducted based on 
specifications from the Statistical Options item of the Settings 
Menu:

Questions?
Call DSI at:
1-877-374-7744 or
visit our website at 
www.DiscerningSystems.com

After the analysis is complete, 
the results are available in 
tabular, graphical and 
worksheet forms.
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Types of Analyses
◗ Confidence levels of 90%, 95% and 99% can be selected.
◗ Prediction limits can be adjusted for various resampling 

protocols if required.
◗ For nonparametric limits, the focus is on individual onsite/ 

downgradient measurements or the median onsite/down-
gradient measurement of one or more locations over time.

◗ If desired, data are also automatically tested for increasing 
and/or decreasing trends using Sen's nonparametric test.

Comparison to Background Statistical Power
If you choose the Statistical Power (for Comparison to 
Background) button, CARStat will compute the statistical power 
for your site as a whole, based on the comparison to background 
analysis results. It is necessary to run Comparison to 
Background analysis first as this analysis creates the input file 
required for the statistical power. During analysis, CARStat will:
◗ Determine the site-wide false positive rate (i.e., the percent-

age of failures when the upgradient versus downgradient 
true mean difference equals zero).

◗ Determine the false negative rates for effect sizes ranging 
from 1 to 5 standard deviation units.

Comparison to Standard
If you choose the Comparison to Standard button, CARStat 
compares the onsite/downgradient data to a fixed regulatory 
standard (e.g. an ACL or MCL). The analysis is based on:
◗ Confidence limits for the mean, median, 90th, 95th or 99th 

upper or lower percentiles of the onsite/downgradient dis-
tribution.

◗ A required minimum of four onsite/downgradient meas-
urements. This requirement can be satisfied with four sam-
ples from one location over time or four locations at one 

After the analysis is complete, 
a line based on the six points 
is displayed on the statistical 
power chart.

After the analysis is complete, 
the results are available in 
tabular, graphical and 
worksheet forms.
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Types of Analyses
point in time or any other combination yielding four inde-
pendent measurements.

All computations are automatically conducted based on 
specifications from the Statistical Options item of the Settings 
Menu:
◗ Confidence levels of 90%, 95% and 99% can be selected.
◗ Normal, lognormal and nonparametric forms of the limits 

are available. In the nonparametric case, confidence limits 
are only available for percentiles of the distribution (i.e. 
median or 50th percentile and the upper percentiles, 90th, 
95th and 99th). For the lognormal case, exact confidence 
limits for both the mean (Land, 1971) and median can be 
computed.

◗ Both lower (LCL) and upper (UCL) confidence limits can 
be selected. LCLs are used in assessment or compliance 
monitoring to determine if a standard has been exceeded 
whereas UCLs are used in corrective action monitoring to 
determine if a standard has been achieved.

◗ The data are also automatically tested for increasing and/or 
decreasing trends if desired using Sen's nonparametric test.

Comparison to Standard Statistical Power
If you choose the Statistical Power (for Comparison to 
Standard) button, CARStat will compute the statistical power for 
every combination of constituent and location, based on the 
comparison to standard analysis results. It is necessary to run the 
comparison to standard analysis first as this analysis creates the 
input file required for the statistical power.

Comparison to Standard statistical power charts show one of 
two things, depending on the "Type of Confidence Limit" 
selection on the Standards tab of the Statistical Options dialog. 

CARStat indicates if 
remediation efforts are 
making the situation better or 
worse by testing for 
increasing or decreasing 
trends in the measurements 
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Types of Analyses
When Upper Confidence Limit (UCL) is selected, the power 
chart shows the likelihood that the UCL of the mean will be 
below the regulatory standard, for the various values of the true 
mean concentration shown on the horizontal axis. For Lower 
Confidence Limit (LCL), the chart shows the likelihood that the 
LCL of the mean will be above the regulatory standard for 
different values of the true mean concentration. The 
concentrations shown on the horizontal axis are expressed both 
as a fraction of the regulatory standard and in natural 
concentration units.

Natural Attenuation
CARStat determines if concentrations have significantly 
increased or decreased relative to the background time-period 
for a particular location. The analysis is based on a prediction 
interval computed from the background data for that location 
and applied to the individual new measurements from that same 
location. Values below the lower prediction limit are indicative 
of a significant improvement in quality whereas values above the 
upper prediction limit are indicative of a significant degradation. 
The data are also automatically tested for increasing and/or 
decreasing trends if desired using Sen's nonparametric test.

Time Series
If you choose the Time Series button, CARStat will generate a 
series of graphs plotting the results over time from the records 
matching:
◗ Constituents specified in the Select for Time Series item of 

the Constituents Menu. AND

◗ Locations specified in the Select for Time Series item of the 
Locations Menu.

Time Series graphs will also 
display significant increasing 
and/or decreasing trends if 
you select the appropriate 
Test for Trends checkboxes 
on the Common card of 
Statistical Options.
10    CARStat



Types of Analyses
Analytical Data Summary
If you choose the Analytical Data Summary button, CARStat 
will create a series of tables based on the locations, constituents 
and dates you have selected. You can easily change the way the 
table is ordered by selecting Data Summary Layout on the 
Settings Menu. CARStat will show you a preview of the tables 
(displaying a sample of real data) and you can alter which items 
to use as the column or row headings.

The data summary can group 
samples taken over several 
days or weeks as a single 
event. See Select Summary 
Dates on the Settings Menu 
for more information.
Demonstration Guide   11





  Getting Started 2  

Hardware & Software 
To run CARStat you must have certain hardware and software 
installed on your computer.
◗ An IBM®-compatible machine with a Pentium® processor 

or higher.
◗ A hard disk with at least 30 megabytes of available space. 

More may be required if your system does not already have 
Microsoft® database access components installed.

◗ 8 megabytes of system memory.
◗ A CD-ROM drive.
◗ Windows® 95, 98, Me, NT 4.0, 2000, or XP.
◗ A mouse or other pointing device is recommended.
◗ A Windows-compatible printer is recommended. CARStat 

supports both color and monochrome printers.

Installation
CARStat is installed on your computer using the program 
INSTALL.EXE. The install program installs CARStat itself, the 
statistical processing modules, the support files, and the online 
help system from the CD-ROM to your hard disk.

Removing CARStat
If you wish to remove 
CARStat from your computer, 
use the Add/Remove 
Programs item from Control 
Panel (found in the Settings 
option from the Start Menu).
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Using CARStat
To install CARStat:

1. Shut down all Windows applications that are running.
2. Insert the CD in your CD-ROM drive (in this case we 

assume it to be Drive D).
3. From the Start Menu, choose Run.
4. Type d:\install and follow the instructions on the screen.

In addition to CARStat itself, the installation program can install:
◗ CARStat file converters. These programs, DUMPMate and 

GritConv, convert CARStat site files to a format readable 
by GRITS/STAT and vice versa. 

◗ Adobe® Acrobat® Reader. Acrobat Reader is required to 
view the User’s Guide PDF and, once you’ve registered, the 
Statistical Guide PDF. These are both accessible from 
CARStat’s Help Menu.

If you do not have Acrobat Reader installed on your computer, 
the box will be checked automatically. However, both of these 
components are optional, and you may proceed with both boxes 
unchecked if you wish.

Using CARStat

Starting the Program
To start CARStat, choose ‘CARStat’ from the CARStat Folder 
in the Programs Folder in the Start Menu.

Please keep in mind that this booklet merely outlines the basic 
information required to use CARStat. For more details, consult 
the online help system or the User’s Guide PDF. Both of these 
reference all aspects of CARStat, and can be accessed through 
the Help Menu. Within the Help Menu, you may search for 
specific topics with the Help Search tool or you may press F1 to 
get context-sensitive help in CARStat or its viewers.

Important
Windows requires that two 
additional components be 
available for CARStat work 
properly. If the installation 
program detects the absence 
of one or both of these 
components, it will install 
them for you. Simply follow 
the instructions provided on 
the screen during the 
installation process—and be 
patient! Do not reboot your 
computer until you are told to 
do so. Leave the CD-ROM in 
the drive while the system 
reboots, and if the installation 
program doesn’t continue on 
its own after the reboot, just 
start it again and it will pick up 
where it left off.
14    CARStat



Using CARStat
Help Contents
For information on Help topics choose Contents from the Help 
Menu or press F1 and click on the Contents button. You can use 
the Contents screen to jump to items in the CARStat menus.

Help Search
1. Click on the Search button from any Help topic window or 

choose Search for Help On from the Help Menu.
2. In the Search dialog box type a keyword or select one from 

the list by scrolling up or down. Press ENTER or click on 
Show Topics (or Display) to display a list of topics related 
to the word(s) you specified.

3. Select a topic name and then press ENTER or click on Go 
To (or Display) to view the topic.

Context-Sensitive Help (F1)
All the menu items, dialog screens and some of the entries on 
those screens contain context-sensitive help. Context-sensitive 
means you can get help on topics directly without having to go 
through the Help Menu. For example, if you want further 
information on an item listed in a menu, highlight the menu item 
and press F1. Information on that menu item will be immediately 
displayed. If you open Help topics in this manner you still have 
access to the Help functions listed above.

Loading the Demonstration Site
CARStat comes with a predefined demonstration site that allows 
you to become familiar with some of its features. A complete set 
of analyses has already been prepared for this site, and you may 
view the output by opening any of the companion viewers.

If you need help on a topic, 
but don’t know specifically 
what menu it falls under, you 
can find it by searching for its 
keywords.
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Viewing Output
To load the demonstration site:

1. Click on Load Another Site from the Site Menu.
2. Click on Predefined Demo Data.
3. Click on OK.

You may now view the various settings for this site by accessing 
the different menu items. You may also view the analysis results 
that have been prepared for this site.

Viewing Output
CARStat comes with four related companion applications which 
allow you to view and print the results of statistical calculations. 
The Graph, Table, Worksheet, and Statistical Power Chart 
Viewers can be accessed through CARStat itself, or 
independently through the Windows desktop.

To start a viewer:

◗ Select the type of viewer from the Functions Menu of 
CARStat. OR

◗ Click on the viewer button on the CARStat toolbar. OR

◗ Click on the desired viewer in the CARStat Folder under 
Programs on the Start Menu (depending on your version of 
Windows). OR

◗ Double click on the viewer button beside an analysis on 
Perform Analyses to directly open the viewer with the 
results for that analysis.

The analyses’ results remain available for viewing even after you 
exit CARStat or a viewer. However, some operations in CARStat 
will result in your output being automatically cleared:
◗ Merging new data
◗ Editing your data
◗ Changing any of the statistical settings

Viewer buttons

 Graphs

 Tables

 Worksheets

 Statistical Power
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Viewing Output
Using a viewer:

◗ Selecting Open from the File Menu of any viewer allows 
you to choose which analysis result you want to view. You 
may have the results for several analyses open at a time in 
any viewer.

◗ The appearance of the output, both on screen and on your 
printer, can be controlled through options found in the File 
Menu of each viewer.

◗ Some analyses produce many pages of output. You can 
move through these pages either by using the scroll bars 
displayed on screen or by using items found on the Navi-
gate Menu.

◗ If you have opened multiple results within the same viewer, 
you can use items found on the Window Menu to display 
all the results.

◗ To close the active analysis results, select Close from the 
File Menu. This will not shut down the viewer itself.

◗ To shut down the viewer, select Exit from the File Menu.

Graph Viewer
A graph is a pictorial representation of the concentration of a 
constituent over time, or as part of a group, which may be 
compared to a standard or limit. Also represented on the graph 
is the time period over which the background characteristics of 
the concentrations were determined if applicable. Exact values 
for points and lines on graphs can be found in the appropriate 
tables.

Table Viewer
A tabular analysis result may contain a single table or a series of 
tables which give detailed results based on statistical calculations 
and/or queries of the database. The rows of the table may be 
grouped by bands of color to indicate related items.

If one of the analyses listed is 
grayed out, then that 
particular analysis has not 
been run since your settings 
were altered.

You may choose to restrict 
the display and printing to 
‘interesting’ graphs (labeled 
Significant Differences). 
These include, but are not 
limited to, exceedances, 
verified exceedances, and 
trends in background.
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Viewing Output
Worksheet Viewer
A worksheet is a series of calculations with accompanying 
explanations which describes which statistical methods were 
applied, which equations were used, and any constants or values 
‘looked up.’ All intermediate calculations are shown so that you 
can follow along the process by which limits and other 
important values are determined.

Statistical Power Chart Viewer
CARStat produces different types of statistical power charts for 
Comparison to Background and Comparison to Standard. 

Comparison to Background

A single statistical power chart is produced for Comparison to 
Background, which shows the chance of detecting 
contamination at a single well for a single constituent, for effect 
sizes ranging from 1 to 5 standard deviation units above 
background. That is, if the concentration of a single constituent 
in a single well were to become elevated by the number of 
standard deviations above background shown on the horizontal 
axis, the curve shows how likely you would be to spot it. The 
values shown are somewhat conservative, as true exceedances 
tend to involve more than one well and constituent, and so are 
more likely to be detected. The false negative rate is the 
likelihood that a genuine elevation of concentration of the size 
shown on the horizontal axis will not be identified by CARStat, 
and can be read off the chart as 100% minus the power for a 
given exceedance size. The false positive rate is the likelihood of 
CARStat reporting an exceedance when the true mean 
difference equals zero, and is read off the graph as the 
percentage where the curve intersects the y-axis (zero effect 
size).   

Typically, an increase for a 
single constituent is 
accompanied by an increase 
in other constituents and/or 
locations making it easier to 
detect exceedances than 
would be expected from the 
values on the curve.
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Viewing Output
Comparison to Standard

Multiple statistical power charts are produced for Comparison 
to Standard, corresponding to every combination of constituent 
and location (Fig. 11-7). Comparison to Standard statistical 
power charts show one of two things, depending on the "Type 
of Confidence Limit" selection on the Standards tab of the 
Statistical Options dialog. When Upper Confidence Limit (UCL) 
is selected, the power chart shows the likelihood that the UCL 
of the mean will be below the regulatory standard, for the 
various values of the true mean concentration shown on the 
horizontal axis. For Lower Confidence Limit (LCL), the chart 
shows the likelihood that the LCL of the mean will be above the 
regulatory standard for different values of the true mean 
concentration. The concentrations shown on the horizontal axis 
are expressed both as a fraction of the regulatory standard and 
in natural concentration units. 

Print Pre-Analyzed Output
You may print any analysis output which exists when you load 
the demonstration site. Analysis results that you create cannot be 
printed until you register the program. To restore the original 
output of the demonstration site, simply choose Restore Current 
Site from the Site Menu.
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 Evaluating CARStat 3 

To try out CARStat with your own data you should first clear the 
current data from the CARStat database and then add in (or 
merge) your own data. At any time, you may reinstate the 
original demonstration site settings by selecting Restore Current 
Site from the Site Menu, or by loading the Predefined Demo 
Data site again.

To clear the database:

1. Choose Clear Database from the Database Menu.
2. CARStat will ask for confirmation twice before proceeding. 

At each prompt, click on Yes. 

Now you are ready to add your own data.

Adding Your Own Data
Initially, you must have an ASCII file of the site’s historical data. 
The structure, or data format, of this file is defined to CARStat, 
and then the file is merged into the database. Future samplings 
will be added to the database simply by merging each new ASCII 
file.

Included with the program are the files CASE1.DAT, 
CASE2.DAT, and CASE3.DAT, which are samples of a site’s 
historical data and have been used to create the demonstration 
database. These files have been prepared in fixed column 
format. This format has been defined to CARStat via the Merge 
Data item on the Database Menu.
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Adding Your Own Data
To merge data files:

1. Choose Merge Data from the Database Menu.
2. Click on Select File to choose the file to merge.
3. Click on the name of your data file and click on OK to dis-

play the file.
The name of the selected file (including the path) is dis-
played in the Merge Data window. If the text exceeds the 
length of the field, you can scroll to the end of field using 
the arrow keys.

4. Look at the flow of your data to determine its format, and 
click on the appropriate radio button to set the segmenta-
tion style:
◗ delimited
◗ fixed columns

Delimited data
1. In a delimited data file each field in a record will be sepa-

rated from surrounding fields by the use of one unique 
character.
a. Find the delimiting character within the data.
b. Choose that character from the delimiter box, or type it 

in if it does not appear in the selection.
2. Make sure the column headers are ordered correctly. You 

may change the order one of two ways:
◗ By clicking and dragging the headers. OR
◗ By entering the correct sequence in the Format Details 

dialog.
3. Select the correct date format from the Date Format box.
4. Choose the correct qualifier.
5. Select Ignore ‘TBK’ Records if necessary.

If the file is not present in the 
scrollable list, try looking in 
other directories, or use the 
list box to show additional file 
types.
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Adding Your Own Data
6. Scroll through the syntax check column to search for error 
messages, and check those records that have been flagged. 
Most errors are self-explanatory, and can be easily fixed.

7. Click on Merge when you are satisfied with the format of 
your records. CARStat informs you of events as they occur 
during the merge; e.g., if any new constituents or sample 
points are encountered, or if some records are invalid, etc. 

8. If any action is required following these events, i.e., setting 
aliases, enter unit equivalences, or reviewing leftover 
records, CARStat will prompt you accordingly.

9. When the merge process is complete, click on Close to 
leave the dialog box.

Fixed columns
1. Click on the black bar between the data window’s horizon-

tal scroll bars and drag it to the right. This allows more 
room to view all of the column headings.

2. The column headers can be moved to fit the corresponding 
columns by clicking in the heading area, holding, and drag-
ging.

3. The column borders can be moved to the left or right by 
clicking on top of them, holding, and dragging.
a. Starting on the leftmost column, scroll down to find 

the widest entry in that column. This is how wide that 
column must be.

b. Widen the column (that is, drag the column border) to 
accommodate this entry.

c. Repeat for the rest of the columns, working from left 
to right.

4. The Qualifier column should be as wide as possible.
◗ The qualifiers themselves can be quite short, and it may 

not be readily apparent that there are any qualifiers if 
the column is not wide enough to ‘catch’ them.

Syntax check
The syntax check column 
checks each record’s format.
◗  ‘OK’ and ‘nondetect’ 

statuses appear in black.
◗  Error messages appear in 

red. These indicate a 
formatting problem in one or 
more of the data fields. 
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The Database
◗ Scroll through as much of the datafile as possible to 
look for any qualifiers, and adjust your columns 
accordingly.

◗ Choose the correct qualifier.
5. Select the correct date format from the Date Format box.
6. Select Ignore ‘TBK’ Records if necessary.
7. If you have adjusted your column widths correctly, all or 

most of the records should be labeled ‘OK’ in the syntax 
check column, with the nondetects and ignores indicated. 
Scroll through the syntax column to search for error mes-
sages. Generally, these should be correctable by adjusting 
the column widths. 

8. Click on Merge when you are satisfied with the format of 
your records. CARStat informs you of events as they occur 
during the merge; e.g., if any new constituents or sample 
points are encountered, or if some records are invalid, etc. 

9. If any action is required following these events, i.e., setting 
aliases, enter unit equivalences, or reviewing leftover 
records, CARStat will prompt you accordingly.

10. When the merge process is complete, click on Close to 
leave the dialog box.

The Database
The contents of the database can be viewed in two ways 
depending on your needs. Both allow you to choose the order in 
which records are shown and search for records based on either 
specific or general criteria. However, View Database shows 
(read-only) records individually while Edit Database provides a 
grid view of all records which can be edited as required.
Since Edit Database allows you to alter records, you cannot leave 
this dialog open on your desktop. You must complete your 
actions before moving on to other areas of CARStat.

Invalid records are saved to 
an automatically-named 
leftover records file.

However, if you wish to look at 
your records while using other 
dialogs, View Database can 
be left open. 
24    CARStat



The Database
View Database
To view or search the contents of the current database, select 
View Database from the Database Menu.

To view records using the data scroll control (labeled Lab 
Results):

◗ Click on the left or right inside arrow buttons to move 
backward or forward one record at a time.

◗ Click on the buttons at the extreme ends of the data scroll 
control to move directly to the first or last record.

◗ To change the order in which records are displayed, use the 
list box to indicate which field should be the major key (i.e., 
sorted first). Then reset the middle and minor keys as 
required.

To search for specific records:

1. Enter the first few letters of the item you want search for in 
the Search Filter boxes. When entering dates, CARStat will 
provide a sample of what format the date should be entered 
in, e.g. mm-dd-yyyy.

2. Click on Update.

The records corresponding only to the search criteria will be 
selected by CARStat and can be viewed using the data scroll 
control.

To view all records after performing a search:

Click on Defaults. All records can now be viewed as before.

Edit Database
To view or edit the contents of the current database, select Edit 
Database from the Database Menu. Note that the database 
editor cannot be minimized and left on the Windows Desktop. 
If you choose Edit Database, you must complete your editing 
actions before CARStat will allow you to move on.

The database editor is 
displayed in tabular form. 
Field headings are displayed 
at the top of the table, and 
horizontal and vertical scroll 
bars will appear as needed.
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The Database
Using the grid viewer
◗ To change the order in which records (rows) are displayed, 

use the list box to indicate which field should be the major 
key (i.e., sorted first). Then reset the middle and minor keys 
as required. The table is automatically reordered when 
changes are made to the ordering options.

◗ To change the order in which the fields (columns) are dis-
played, place the cursor over the column heading, depress 
the left mouse button, and drag the column to its new posi-
tion.

◗ To change the width of a column, place the cursor any-
where on a vertical line on either side of the column. The 
cursor will become a double-sided arrow. Depress the left 
mouse button and drag the column boundary to its new 
width. If you make the column too small, it will ‘disappear’ 
from the grid. The column still exists, but you must exit 
and re-open the grid viewer to view it.

Using the editor
◗ To find a specific record or area in the database enter the 

first few letters of the item you want search for. Pressing 
the Find button will take you to the first record which 
matches or exceeds any combination of constituent, well, 
or date.

◗ To edit a record, including marking or un-marking a man-
ual outlier, highlight the record and then click on Edit.

◗ To add a record, click on Add.
◗ To delete a record, highlight the record and then click on 

Delete.
◗ To display the log of all changes made to the database, click 

on Log.

All changes to the column 
display of records affect only 
that session of the grid 
viewer.
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The Monitoring Network
Data Export/Print
CARStat allows you to export data from the database for use 
with other programs or for conforming with electronic reporting 
regulations in some states. You may choose a subset by 
constituents, sample points, a date range, or any combination of 
these. The data are output in a fixed column width ASCII text 
format, which is easily read into most spreadsheets. You may 
also choose to print the selection of data in a format similar to 
the tabular output. Choose Print/Export Records from the 
Database Menu.

The Monitoring Network

Constituents
In order to operate, CARStat needs to know which constituents 
you want to use in your analyses. Your selections will remain 
intact for that site until you choose to change them.

To select constituents for analyses:

1. Choose Select for your desired analysis from the Constitu-
ents Menu. All selections operate in the same manner 
except for Select for Standards Comparison which is 
described later.

2. A constituent can be moved from the Available List to the 
Selected List by clicking on the desired constituent(s) in the 
Available List and then clicking on Add.

3. A constituent can be moved from the Selected List to the 
Available List by the same method; click on the desired 
constituent(s) in the Selected List and then click on 
Remove.

4. When your are satisfied with the Selected List, save the list 
by clicking on OK.
OR

We have provided an outline 
of the steps required to run 
any of the analyses or 
reports.
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The Monitoring Network
If you have made changes to your Selected List and do not 
wish to save them, click on Cancel. A message will appear 
asking if you wish to save your changes. Click on No.

Locations

Comparison to Background
If you wish to perform a comparison to background analysis, 
CARStat needs to know which locations you want to use in your 
analysis and whether they reflect background locations, onsite 
locations, or both. Your selections will remain intact for that site 
until you choose to change them.

Unlike some of the other Available Lists, the items are not 
physically removed from the list once selected. Instead, the 
Available List reflects how a location has been defined by 
placing an indicator beside its name. A location in the Available 
List is marked with the designation of [B] if it is included in the 
Background List, [O] for the Onsite List, [&] for both, or [  ] for 
neither.

To select locations for Background to Comparison:

1. Choose Select for Background Comparison from the Loca-
tions Menu.

2. Move the desired locations to the Background List or the 
Onsite List by clicking on the location(s) in the Available 
List and click on the appropriate Add button.

3. A location can be removed from either the Background 
List or the Onsite List by the same method; click on the 
desired location(s) in either list and click on appropriate 
Remove button.

4. When you are satisfied with the lists, save them by clicking 
on OK.
OR

CARStat automatically 
remembers all of your 
preferences and settings. 
Each time you start the 
program it’s just like you 
never left.
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The Monitoring Network
If you have made changes to your lists and do not wish to 
save them, click on Cancel. A message will appear asking if 
you wish to save your changes. Click on No.

Other Location Selections

To perform the other analyses, CARStat needs to know which 
locations you want to use. Your selections will remain intact for 
that site until you choose to change them. Choose Select for the 
appropriate analysis from the Locations Menu.

Groups
Groups allow you to combine a series of locations into a single 
entity which contains all the sampling results of the individual 
locations that together constitute an area of interest or PAOC.

To define a new group:

1. Choose Define Groups from the Locations Menu.
2. Click on New Group, enter a name of up to 16 characters 

for the group in the dialog which appears and click on OK.
3. Select the desired location(s) from the Available Locations 

list and click Add.

To view the components of a group, including one you’ve just 
created, click on the picture to the left of the group you are 
interested in. The list of locations included in that group will 
appear below the group. If you wish to alter the group you may 
select an entry and click Remove. You can also remove an entire 
group using the Remove button. If you have made changes to 
your lists and do not wish to save them, click on Cancel. A 
message will appear asking if you wish to save your changes. 
Click on No. Once a group has been defined it can be selected 
just as any other individual location would be throughout the 
program.

Use the standard technique 
for defining the Selected Lists 
as described above for the 
constituents.

You can define an unlimited 
number of groups to fully 
characterize all of your 
PAOCs from initial 
investigation
to fully refined.
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The Monitoring Network
Set Time Windows
With CARStat you can independently control the period of time 
used for establishing your background (that is, your benchmark) 
and the period of time over which to perform your comparisons. 
There are three separate time periods:
◗ Comparison to Background—indicates the period over 

which we are characterizing the site (i.e., what is considered 
normal).

◗ Onsite/Downgradient—indicates the period over which 
you do the comparison. This period applies to both the 
Comparison to Background and the Comparison to Stand-
ards analyses.

◗ Natural Attenuation—indicates the period over which you 
would set the background for an onsite or downgradient 
(i.e., impacted) location.

To set the time windows:

1. Choose Set Time Window from the Locations Menu.
2. Select the Time Period for Location that you wish to set a 

time window for. Make sure that it is the only list item 
highlighted unless you wish to set the same window for 
multiple selections.

3. Enter the appropriate dates for Start Display, Start Analysis 
and End Analysis.

4. Click on Update Selected Locations to copy the changes 
displayed on the detailed time bar to the selected/high-
lighted wells in the Time Periods for Locations box.

5. When you’re happy with your settings, save the lists by 
clicking on OK
OR
If you have made changes and do not wish to save them, 
click on Cancel. A message will appear asking if you wish to 
save your changes. Click on No.

Time windows allow you to 
easily change from analyzing 
your site historically to a 
snapshot at any particular 
time.
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The Monitoring Network
Standards

Constituents

If you wish to perform a Comparison to Standard analysis 
CARStat needs to know which constituents are to be assessed, 
and what standard concentration to use for each constituent (as 
defined by your state or other regulatory agency).
The Comparison to Standard constituent list reflects the status 
of the constituents as either unselected, selected with a standard, 
or selected without a standard. Selected constituents with no 
standard will have a red ‘X’ beside the constituent name. 
Selected constituents with a standard will have a green light 
beside the constituent name.

To select constituents for Comparison to Standard:

1. Choose Select for Standards Comparison from the Constit-
uents Menu.

2. A constituent can be selected for analysis by clicking on the 
desired constituent in the Constituents List and then click-
ing on Select.
A constituent can be deselected by the same method; click 
on the desired constituent in the Constituents List and then 
click on Deselect.

3. Define the standard concentration for each selected con-
stituent.
a. Click on the constituent and then click in the Standard 

box.
b. Type the number, then press the ENTER key.

4. When all desired constituents have been selected, save the 
list by clicking on OK.
OR
If you have made changes to your list and do not wish to 
save them, click on Cancel. A message will appear asking if 
you wish to save your changes. Click on No.

A Comparison to Standard 
analysis cannot be performed 
until all selected constituents 
have been assigned MCLs or 
other appropriate regulatory 
criteria.
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The Monitoring Network
CARStat also allows you to set standards to comply with state or 
regional regulatory limits. The drop-down list boxes at the top 
of the dialog allow you to set all of your constituents to the 
mandated concentrations at once. The State list box is used to 
select the state or region from which the standard comes. Once 
the state has been selected by either tabbing off the control or 
pressing ENTER a list of available choices will be displayed for 
the selected State. This continues for Matrix, Land Use, 
Exposure and Author until an Author is selected. Once this has 
been selected the concentrations stored in the database for that 
standard are automatically applied to all of your constituents. 
Please note that if there is only one selection for the next step in 
the selection process that CARStat will automatically select it. 
This behavior will continue until an Author is automatically 
selected or a user selection is required. Once a new standard has 
been selected, the list boxes have their background colors set to 
white. A yellow background color indicates that at least one 
concentration has been changed from those defined by the 
displayed standard.

Standards Manager
But what if you would like to define a new standard or 
incorporate values from a local agency? CARStat includes a 
Standards Manager which allows you to define a new standard 
which contains the concentrations listed in the Standards dialog. 
Simply enter descriptors for all of the text entry boxes used to 
describe the standard and press Update Database Info. When 
you close the Standards Manager you will see that the newly 
defined standard is displayed in the list boxes at the top of the 
standards dialog.

The Standards Manager can also be used to import new 
standards from an ASCII text file. If you wish to incorporate a 
set of concentrations from a text file click Import Standard and 
follow the instructions below.
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Statistical Options
Importing

A standards file from a regulatory body can be incorporated into 
CARStat through the Standards Import function which is 
accessed through the Standards Manager described above. The 
Standards Import dialog is similar to Merge Data in what it 
does—importing values from a text file and Edit Database in 
how you use it.

To merge in a new standard:

1. Select the file you wish to import. The file must contain a 
constituent name, concentration, and unit on each line. The 
unit need not be the one used by CARStat for that constit-
uent; the concentration will automatically be converted to 
the unit used by your database. If one has not already been 
defined, you will be prompted for a conversion factor.

2. Choose Fixed Column or Delimited for the format; if 
Delimited, choose the delimiter from the list box, or else 
enter your own.

3. Organize the columns until the field are segmented appro-
priately.

4. Click on Import to incorporate the values.

The columns can be manipulated as described for Edit Database 
on page 25 except that new columns can be created by double 
clicking to the right of the column where you wish to insert, and 
the three ‘titled’ columns have a minimum width of two 
characters—they cannot be completely hidden.

Once a set of standards has been imported you will return to the 
Standards Manager, where you can define that standard to 
CARStat and save all the concentrations to its database of 
standards.

Statistical Options
CARStat’s statistical options are found on the Settings Menu. 
You can alter these settings and rerun the analyses to see the 

A sample fictitious standards 
file (demo.std) is included 
with the CARStat installation.

The “CSV” selection correctly 
interprets files which not only 
use commas as delimiters but 
may also contain commas 
within each item. The items 
are enclosed within quotation 
marks to separate internal 
commas from delimiting 
commas.
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Performing Analyses
effect of your changes. To illustrate the consequences of these 
options, there are some sample exercises on page 37. Note that 
when you change the settings, CARStat will automatically erase 
all output. Therefore, we recommend that you follow the 
exercises in order (before you alter any settings in CARStat), as 
we have ensured that analysis results are available for viewing as 
required.

You can set values for ‘Common’ settings (applicable to all 
analyses), Comparison to Background, Comparison to Standard, 
and Natural Attenuation; just select the appropriate tab. The 
online help provides details on what effect each option has. 
Detailed statistical explanations are available in the CARStat 
Statistical Guide which is included with the licensed version of 
the software.

Performing Analyses
With CARStat you can perform analyses in two ways, either 
individually or by running a group of analyses together. You 
choose which analysis or analyses to run from the Perform 
Analyses item on the Functions Menu. Each analysis is 
represented by a button. To run an individual analysis, simply 
double click on that button. Or, you may wish to set up a series 
of analyses to run with automatically-activated output viewers 
upon completion.

To set up multiple analyses with specifically-activated output 
viewers:

1. Choose Perform Analyses from the Functions Menu.
2. Click once on the buttons of the analyses you wish to have 

performed. All buttons can be depressed, even if the title 
appears grayed out. If the ‘go sign’ (the green light • ) 
appears, all the necessary steps have been taken to run that 

A brief description of each 
analysis begins on page 7.
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Performing Analyses
particular analysis (i.e., the monitoring network is defined, 
the statistical options completed, etc.).

3. If the green light does not appear on one of your selections, 
double click on that button. CARStat will state why the 
analysis cannot be run at this time.

4. If you wish, indicate the type of output you would like 
automatically displayed after the analyses are complete. Sin-
gle click on the desired output button to the right of each 
analysis button. Output choices include graphical, tabular, 
worksheets and a statistical power chart.

5. In the Comprehensive frame, select As Marked to ensure 
that the output choices you have made are automatically 
shown upon completion of the analyses.

6. Click on the ‘Do those with • ’ button. All possible selected 
analyses will be run in sequence. The statistical power chart 
for Comparison to Background cannot be created until the 
preceding Comparison to Background analysis is run.

7. Click on Close or Cancel to leave the Perform Analyses dia-
log.

Perform Analyses can also be used to see which results are 
available and to act as a launch point for directly opening the 
viewers with the desired results. You can also access Print 
Results (see Print Pre-Analyzed Output on page 19) from this 
dialog.

As the analyses are running, 
CARStat will show you which 
analysis in the sequence it is 
currently working on.
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  Practice Exercises 4  

Following are a few exercises that can be done with our sample 
database to illustrate some of CARStat’s features and 
capabilities.

We recommend that you follow these exercises in order, as we 
have ensured that analysis results are available for viewing as 
required.

Comparison to Standard
Our first analysis is a comparison of monitoring data to a state-
issued regulatory standard, where the data from individual 
sampling locations are compared location-by-location to that 
standard. At each location, the confidence limit for the mean is 
compared to that standard. 

In assessment monitoring you typically compare the lower 
confidence limit for the mean against a standard to establish with 
a reasonable certainty if the true concentration exceeds a 
standard. In remediation or corrective action monitoring, you 
compare the UCL for the mean to a fixed regulatory standard. If 
the UCL is less than the standard we are now confident that the 
remediation has reduced the true concentration to a level that is 
below the regulatory standard.

Remember
When you alter any statistical 
settings in CARStat, all 
current output is erased. 
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Exercise
CARStat allows you to compare the upper or lower confidence 
level for a percentile of the distribution to a state-issued 
standard. In this case we are in corrective action monitoring and 
need to determine if the true mean concentration is below the 
regulatory standard
1. Choose Statistical Options from the Settings Menu.
2. On the Common tab note that the Distribution Type is set 

to Normal and that the Confidence Level is 95%.

3. Click on the Standards tab to review the options for this 
specific analysis. The Type of Confidence Limit is Upper 
and the Percentile is the mean since we are testing to see if 
the true mean concentration is below the standard with 
95% confidence. Click on Cancel.

In this example, the sampling 
data is considered to be 
normally distributed. You can 
let CARStat determine the 
distributional form 
automatically, or you can 
manually specify the 
distribution as normal, 
lognormal, or nonparametric.

Note that for a symmetric 
distribution such as the 
normal, the mean and 50th 
percentile (median) are the 
same. This is not true for the 
lognormal distribution. For a 
nonparametric confidence 
limit, only confidence limits for 
percentiles exist.
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4. Rerun the Comparison to Standard analysis by double 
clicking on that button on the Perform Analyses dialog of 
the Functions Menu.

5. Bring the Graph Viewer to the front by clicking on its entry 
in the task bar. The first entry Hex chrome for location 
HA1-ROW has large values for its samples and confidence 
limit.

6. Use the scroll bar at the bottom of the viewer window to 
view other graphs.

7. Try changing the vertical axis scaling to Logarithmic by 
choosing it from the Scaling options from the File Menu 
and observe how the axis labels change and the smaller val-
ues become easier to read.

8. Bring the Worksheet Viewer to the front and review the 
calculation of the confidence limit for each location and 
constituent. This limit is the thick green line on the graphs 
which exceeds the thin blue line of the standard.

9. Close the viewers and return to CARStat.

Comparison to Background
CARStat allows you to pool data that belong together when 
evaluating a potential area of concern (PAOC). Collections of 
sampling locations can be specified and named as a group using 
Define Groups found on the Locations Menu. Groups can be 
included in selection lists for analyses just like individual 
sampling locations. They also allow some additional statistical 
and output options.

Exercise This is an opportunity to see how CARStat can display samples 
at locations as collections of groups rather than as 
concentrations over time to help you characterize the spatial 
properties of your site.

You can also change the 
scaling of the vertical axis by 
clicking on the axis.

The demonstration site 
includes predefined groups, 
some of which have already 
been selected for the 
Comparison to Background 
analysis.
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1. Choose Statistical Options from the Settings Menu.
2. Change the Distribution Type to Best Fit on the Common 

tab.
3. Click on the Background tab and note that the Comparison 

Type is Onsite/Downgradient Mean indicating that the 
mean of the sample data for each group will be compared 
to a prediction limit for the mean computed from the back-
ground data. Click OK.

4. In the Perform Analyses dialog, single click on all the analy-
sis buttons except for Comparison to Background and its 
Statistical Power so that only those two have the •  showing.

5. Click on the ‘Do those with • ’ button to rerun those two 
analyses.

6. Use the scroll bars to move between the displays for the 
two predefined groups in the graph and worksheet viewers.

7. The graph shows the mean concentration at each location 
plotted on the Y axis, with the sampling locations that 
make up each group along the X axis. To see the location 
name that goes with each number, right click on the axis 
itself. The onsite mean for the group is shown as a thick 
green line.
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8. Bring the Power Chart Viewer to the front and review the 
curve. It displays the effectiveness of your current settings. 
Select Statistical Power Chart Overview from the Power 
Chart Help Menu for a detailed explanation.

Examining and Defining Groups
The groups of locations which were used in the previous 
exercise were easily defined in CARStat using Define Groups 
from the Locations Menu. In Define Groups you can quickly 

A good statistical power curve 
has a false positive rate (X=0) 
close to 5% and power of 90% 
or more at less than 4 
standard deviation units over 
background (X<=4).
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define new groups or examine and edit the contents of existing 
groups.

Exercise In this exercise you will add new groups, edit existing ones and 
see how to delete groups you no longer need. The Define 
Groups dialog contains list boxes similar to those used for 
selecting constituents and locations but has a little twist: the list 
of already defined groups appears on the right, each with a 
‘container’ symbol ( ) beside it to indicate that it is a group with 
locations already specified.
1. Choose Define Groups on the Locations Menu.

2. View the component locations of Group 1 by clicking on 
the container symbol beside its name. The group members 
appear under the group’s name. The container symbol also 
changes to indicate that you are viewing the contents.

3. Add a member to Group 1 by selecting it in the Defined 
Groups list, choosing the location HA12-ROW in the 
Available Locations list on the left and clicking Add. You’ll 
see the new location appear under the selected heading on 
the right. HA12-ROW is not removed from the Available 
list, however, since a location may be a member of more 
than one group
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4. Delete a member from Group 1 by selecting HA13-ROW 
in the Defined Groups list under Group 1 and click 
Remove to remove it. For all future analyses involving 
Group 1 HA12-ROW will be included and HA13-ROW 
will not.

5. Create a new group by clicking on New Group and enter 
Group 2 in the text box which appears. After clicking OK, 
select HA12-ROW, HA12A-ROW, HA2-ROW and 
HARW-2 and click Add. You can click on the symbol next 
to Group 2 to expand the group for viewing.

6. Click on OK to save your newly defined and edited groups.
7. Choose Select for Natural Attenuation on the Locations 

Menu, add Group 2 to the Selected Locations list and click 
OK to save and exit.

8. Rerun the Natural Attenuation analysis by double clicking it 
in the Perform Analysis dialog from the Functions Menu. 
When the viewers launch you will see results for both 
Group 1 and Group 2.

9. Close the viewers and return to CARStat.

Importing Regulatory Standards

CARStat maintains a database of regulatory standards that you 
can select before running your analyses. Though it is possible to 
manually enter concentrations for each of the constituents, an 
import feature makes it easy to bring in lists of regulatory 
standards concentrations from a text file.

Exercise In this exercise you will import a text file containing regulatory 
standards. Such files may be available on the Internet or from 
state or other regulatory agencies.

The component locations of 
groups can be changed at 
any time and new groups can 
be added as required.

Complete sets of state 
standards will be available for 
purchase as optional 
components.
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1. Choose Select for Standards Comparison on the Constitu-
ents Menu.

2. Click on the Standards Manager button which opens a new 
dialog with data entry boxes to describe the current set of 
regulatory limits.

3. Click on the Import Standard button which opens the dia-
log where you select and import standards after checking/
setting the format. To learn more about importing stand-
ards text files, click on Help.

4. Select the “Delimited” option button, and choose 
“<CSV>” from the drop-down list that appears. Click on 
Select.

5. In the Select Standards File to Import dialog, confirm that 
the current directory is the CARStat demo directory and 
select DEMOCSV.STD.

6. You should now see a preview of how the input file will be 
interpreted. Confirm that there are three columns, and that 
the Constituent column contains the names of analytes, the 
Standard column contains numerical values for the concen-
tration limits, and that the “Units” column contains the 
units of measurement for the Standard. Note that not all 
constituents have limits defined for them.



7. Click on Import and you will be returned to the Standards 
Manager to enter a description of your newly imported 
standard. Make the following entries: State = Fictitious, 
Matrix = Groundwater, Land Use = Industrial, Exposure 
= Consumption, Author = Demo, and any comment you 
wish.

8. When all the fields are entered, click on Update Database 
Info and then Close to return to the main Standards dialog.

We have now changed the current standards values to those 
imported from the text file. You will see that the green lights 
beside Hex chrome and Total chrome have changed to red X’s 
indicating that the standards we imported did not include values 
for them. To return to the standards you were using at startup, 
click on the State list, choose Demo and press ENTER. You 
should see the rest of the list boxes change back to the Demo 
settings, and the red X’s beside Hex chrome and Total chrome 
change back to green lights.
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